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ABSTRACT

The Utility Fuel Inventory Model (UFIM) is a tool intended to help power
companies develop reasonable, low-cost fuel inventory policies. The prin-
cipal goal of inventory management is to balance the cost of building and
maintaining fuel reserves against the risk of running out of fuel. UFIM uses
analytic techniques to provide utilities with insights about how to strike this
balance.

UFIM was originally designed for running on mainframe computers and then
converted to run on your PC under the MS-DOS operating system. Ver-
sion 4.0 was created so that the program would run under modern windows
operating systems. The new user interface is a standard Windows imple-
mentation. In addition the calculation engine was converted from Fortran
to C++.

Please note that the underlying algorithms and calculations in UFIM have
not changed.
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ABOUT THE DOCUMENTATION

The purpose of this documentation is to describe the new Windows user
interface incorporated in UFIM Version 4.0. This document also provides
instructions for installing UFIM on your PC. This document complements,
and does not replace, the standard UFIM documentation, which remains
unchanged from Version 3.0 and earlier.

The original UFIM documentation consisted of a single binder containing
two volumes: “UFIM Basic Concepts” and “UFIM User’s Guide.” The
purpose of the “UFIM Basic Concepts” volume was to discuss the general
nature of the inventory problem, to describe the features of UFIM, and to
provide interested planners and decision makers with sample applications
of the model. A companion volume, the “UFIM User’s Guide,” provided
detailed descriptions of the computer model input and output sets, both
for the mainframe version of the model and the original personal computer
counterpart.

This update documentation replaces the information in the “UFIM User’s
Guide.” An electronic version of the “UFIM Basic Concepts” volume is
distributed with the Version 4.0 software and can be accessed from the help
menu.
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TO GET HELP

TO REPORT PROBLEMS AND GET HELP RUNNING THE MODEL,
CONTACT EPRI USER SUPPORT:

The EPRI project manager
Jeremy Platt
(650) 855-2624
jplatt@epri.com

The software developer
Mukund Thapa
Stanford Business Software, Inc.
(650) 796 4478
mukund@sbsinc.net

The software support specialist
Steve Chapel
S. Chapel Associates
(650) 856 2675
s.chapel@earthlink.net
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1 INTRODUCTION

This User’s Manual provides descriptions of the inputs and outputs for the
UFIM Version 4.0 software. This chapter provides instructions on installing
the model, how to learn to use the model, and brief description of how Ver-
sion 4.0 differs from earlier versions. Chapter 2 describes the user interface
and specifically describes the inputs and outputs.

1.1 Installing the Model

The accompanying CD disk contains the setup program that will install the
model. The system requirements for the model are:

• Windows 98 SE/Win ME/ Win NT/ Win 2000/ Win XP,

• 64mb of RAM,

• 100mb of free space on a hard drive,

• Acrobat Reader 4.0 installed on the host machine.

The model uses Acrobat Reader to display the help file. If the user does not
have Reader it can be downloaded for free from Adobe’s web site (www.adobe.com).

To install the model insert the disk in the CD-ROM drive. If the setup
program does not start automatically, click START , select Run, enter D :
/SETUP in the dialog box and click OK (if D : is not the drive identifier
for the CD-ROM, enter the appropriate drive identifier). Then, follow the
directions on the screen to complete the setup. Unless the user specifies
otherwise during installation, the program, reports and database files are
placed in the folder c : /ProgramFiles/EPRI/UFIM . The DLL files are
placed in the directory c : /windows/system. (NOTE: For Windows NT
and Windows 2000, windows directory is winnt)

To uninstall the model click START , select ControlPanel, select AddorRemovePrograms
from the list, select UFIM from the list, click the Remove button. When
ask ”Are you sure you want to remove UFIM from your computer,” click
the Y es button. When done close the AddorRemovePrograms window and
the Control Panel window.

Note: Administrative privileges are required to install the application on
Windows NT 4.0, XP and 2000
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The database Sample.mdb is distributed with the program. This database
is automatically opened when the program is started. The database includes
two cases - Non − seasonal and Seasonal. The Seasonal case is the basis
for the screen shots used in Chapter 2. To verify that the model is correctly
installed and working, the user can run the Seasonal case and compare the
outputs with the screen shots in Chapter 2.

Note: when the program is run it automatically opens the last database
created by the user. The first time the model is run the database will be
Sample.mdb, the database distributed with the program.

In the next Chapter 2 we explain the details of running the model including
entering data and reviewing output reports.

1.2 Learning to Use the Model

UFIMTM is an easy model to use. If the user is not familar with the model
we recommend the following five steps as an efficient way to become familiar
with (1) the mechanics of running the model and (2) the methodology that
underlies the model calculations:

1. Review Chapter 2 to become familiar with the user interface, the input
data, and the outputs.

2. Study the inputs for both the Seasonal and Non-Seasonal cases sup-
plied with the Version 4.0.

3. Run the Seasonal and Non-Seasonal cases and study the outputs.

4. Read Chapter 3, of the “UFIM Basic Concepts” volume, ”Getting
Started With UFIM,” The manual is distributed with the software
and can be opened from the Help menu.

5. Prepare a case based on the problem described in Chapter 3 of the
User’s Manual.

1.3 What’s New

Version 4.0 reproduces the calculation capability of Version 3.1. A modern
Windows interface was added and the software was rewritten in C++ to take
advantage of increased speed and improved memory management. Context

2



sensitive is available for all input fields. Placing the cursor in any field and
pressing F1 will active the help.

1.4 Error Traps

The software traps most data inconsistencies at the user interface level.
However, there are certain situations where error conditions are recognized
only after the model is processing the data. In order to ensure robustness of
the software, the software traps run-time generated errors and reports them
back to the user in a Window as a RUN-TIME ERROR. When this happens
the user is asked click OK and the model returns to the main window.

In some (hopefully rare!) instances, the error message is one that should
not have occurred and occurs only because of an internal inconsistency in
the software. In this case, the names and phone numbers of contacts at
EPRI and Stanford Business Software, Inc. (SBSI) will be displayed. Please
contact at least one of the support organizations with the exact message as
it appears on your screen.

In other situations, the error message will point you in the right direction
and you can attempt to modify the data for the case and re-run the model
(after restarting the software). However, in this case too, should the message
be unclear or if you have any questions, please do not hesitate to contact
EPRI or SBSI.

3



1.5 Contacting Us

TO REPORT PROBLEMS AND GET HELP RUNNING THE MODEL
CONTACT EPRI USER SUPPORT:

The EPRI project manager
Jeremy Platt
(650) 855-2624
jplatt@epri.com

The software developer
Mukund Thapa
Stanford Business Software, Inc.
(650) 796 4478
mukund@sbsinc.net

The software support specialist
Steve Chapel
S. Chapel Associates
(650) 856 2675
s.chapel@earthlink.net
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2 USING THE UFIM USER INTERFACE

2.1 Introduction

This Chapter describes the UFIM user interface and the way inputs and
outputs are handled by the interface. The user interface is a standard Win-
dows implementation. It was written in Visual Basic and output reports are
created as text files. Because of the Windows implementation, users should
be able to edit data sets, run the model and view results with little or no
reference to this User Guide. However the modeling process requires con-
siderable thought and it is highly recommended that model users carefully
study the methodology described in the UFIM Basic Concepts volume.

2.2 Running the Model

To run the model click START , select Program, and highlight the UFIM4.0
program, and click/double-click the program icon. The program icon is sim-
plified tree structure. Figure 2-1 is an enlarged picture of the icon. The user
can also open the program by double clicking the Project Prioritization Sys-
tem program icon on the DESKTOP .

Figure 2-1: UFIM Program Icon
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When the model is started, a start-up window is displayed. This screen has
the name of the program, the version number, and the list of individuals
that developed the program. The user can click any key to close the start-
up screen.

Once the opening screen is closed, the LicenseNotice window is displayed
until the user click any key. Once the license notice disappears, the model
finds the default database installed with the program (Sample.mdb) and
opens the database. If the model cannot find the database, a window will
popup and ask user to browse and specify the database path. (Default
directory to be searched is c : /ProgramFiles/EPRI/UFIM). Following
this, the window for Select Case is displayed as in Figure 2-2. This window
gives the user the option to select an existing case or create a new case.
Initially, if no cases are entered, Work on existing Case is grayed out. If
cases already exist in the database, the Work on existing Case option is
enabled. This window is shown below.

Figure 2-2: Select Case

If the user selects Work on Existing Case, a window is opened that allows
the user to select the case from a list. If Create New Case is selected, a
window is opened that allows the user to specify a new case a name and
description.

If database has one or more cases, and the Work on Existing Case option in
Figure 2-2 is selected, a popup window shows all the cases in the database.
The user can select any of the cases and the model will open the correspond-
ing case. The case used by the program is displayed at the top of the main
screen. Figure 2-3 shows the window displayed to open a case.

After an existing case is selected or a new case created, the main window is
displayed as shown in Figure 2-4.

Using the main window menu system you can perform file functions, edit
cases, run cases, view results and open the documentation.

6



Figure 2-3: Open Case

Figure 2-4: Main Screen
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2.3 The File Menu

The file menu is used to open new and existing input data sets and to save
input data sets. The file menu options are described next. The main screen
with the file menu open is shown below in Figure 2-5.

Figure 2-5: Main Screen With File Menu Open

New Case Create and name a new case to adds the case to the database. The
case will be added to the current case database.

Open Case: Select a previously-defined case to open. You may select among cases
in the current case database.

Save Case: Saves the opened case to the current database.

Save Case As: Save opened case under a different case name in the current case data-
base.

Delete Case: Permanently remove an existing case from the current case database.

Print Case: Displays the input data for the current case, so that you can print or
save it to disk.

8



Database Options: This menu contains options for Creating, Opening, Copying and Delet-
ing a database.

Exit: Leave UFIM and return to the operating system.

2.4 The Edit Menu

The edit menu is used to edit case data, run specifications and advanced
user parameters.

2.4.1 Editing Case Data

Figure 2-6 shows the edit menu with the Edit Case Data option selected.
This option allows you to view or change all of the input data of the current
case.

Figure 2-6: Edit Menu - Editing Case Data

NOTE: An extensive context-sensitive help system provides guidance for
each data input element (if the user puts the curser in any data element
and presses F1 help is provided). In addition all of the data elements are
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explained in detail in the origioanl user manual “UFIM Basic Concepts” in-
cluded with this software. Because of these two fact the input forms activated
by each of the edit menu items are not reproduced here.

Basic Data: Basic Data refers to a general class of information about your utility
and how you want to set up the model. It includes initial inventory
levels, financial data, and details of the fuel you burn (fuel heat con-
tent) and how fast you burn it (plant heat rate). It also includes your
choice of options (Seasonality, Period, Run Level, and STEP) that
affect the overall structure of your analysis.

Normal-Times Fuel Costs: Supply Information - Normal Times Fuel Costs contains data con-
cerning your utility’s fuel supply line. It includes fuel prices, supply
constraints, and a description of any uncertainty in your fuel supply.

Dist. On Supply Error: Supply Information Distribution On Supply Error contains descrip-
tion of any uncertainty in your fuel supply.

Normal-Times Demand Data: Normal-Times Demand Data provides a description of your normal
pattern of demand for fuel. Since demand may be uncertain, demand
data is entered in the form of probability distributions.

Normal-Times Shortage Costs: If a power plant runs out of fuel, the utility must replace the forgone
generation from the plant or curtail service. The total shortage cost
incurred is equal to the cost of replacement power, less the cost that
would have been incurred had sufficient fuel been available.

A Normal-Times Shortage Cost Curve indicates the marginal cost of
replacement power during Normal-Times as a function of the amount
of burn reduction (the percent of time that the plant is not run). That
is, for each level of burn reduction the curve represents the added cost
of reducing plant output by another megawatthour. When calculating
shortage costs, UFIM uses the average cost represented by this curve
for the cost of replacement power during Normal-Times.

Basic Disruption Data: Disruption Basic Data is the first of two categories of disruption data.
It includes disruption frequencies, warnings, and burn reduction op-
tions.

Disruption Data: Disruption Data is the second of two categories of data concerning
disruptions. It includes durations, fuel prices, demand for fuel, delivery
constraints, and replacement power costs for each disruption.
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2.4.2 Editing Run Specifications

Figure 2-7 shows the edit menu with the Edit Run Specifications option
selected. This menu item allows the user to select or change options that
determine how UFIM will run the current case.

Figure 2-7: Edit Menu - Editing Run Specifications

Run Options These options affect how UFIM operates. In particular, they deter-
mine the submodels to be used and the name of the output file.

Disrup./Target Options These options concern the selection of disruption and target data for
use in a UFIM run.

Report Options These options concern how UFIM will report output after the run.

Select Disruptions: This item allows the user to select among previously-defined disrup-
tions to include with the run.

2.4.3 Advanced User Parameters

Through this menu item you can access a series of technical parameters
that affect UFIM’s operation. These parameters give advanced users more
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control over how the UFIM model runs. Most users, however, will not need
to change them.

2.5 Run Case Menu

This menu contains options for running one or more cases. You can run the
current case or run multiple cases. The options in the Run Case menu are
shown in Figure 2-8.

Figure 2-8: Run Case Menu Options

2.5.1 Run Current Case

If the option Run Current Case is selected the user is promted by a dialog
box, Figure 2-9, asking if it is OK to run the case.

Figure 2-9: Run Case Dialog Box
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If yes is selected the model runs and when complete a Run Log report is
displayed, Figure 2-10.

Figure 2-10: Run Log Report
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2.5.2 Run Multiple Cases

If the Edit menu option Run Multiple Cases is selected, one or more previously-
defined cases can be run. You may select any set of cases in the current case
database. The dialog box for selecting cases is shown by Figure 2-11.

Figure 2-11: Input Form for Selecting Multiple Cases to Run

2.6 Results Menu

This menu contains options to select model outputs for viewing, printing,
or exporting to a spreadsheet. Figure 2-12 shows the menu options with the
View Results option selected.

2.6.1 View Results

If the Seasonal Case is selected a form is show where the user can select
one of several output reports, Figure 2-13. The output options are (1) A
summary report, (2) a normal-Times report, (3) a disruption report, (4)
a report listing the case inputs, (5) the run log, and (6) your own table
selection.
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Figure 2-12: Results Menu With The View Results Option Selected

Figure 2-13: View Results Options
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2.6.2 Export to Spreadsheet

This menu option allows users to select model outputs to save in spreadsheet-
readable format. The file will have the same name as the run from which it
was created, with the extension .CSV (Comma Separated Values).

NOTE: Because the .CSV file will have the same name as the run (for
example Seasonal) the user will need to rename the spreadsheet files if they
wish to make multipe runs with the same case and export after each run.

2.6.3 Delete Results

This menu option allows users to delete all output files generated by a run.
This does not delete the case’s original input data.

2.7 Help Menu

The Help menu has six items: (1) Introduction to UFIM, (2) Getting
Started, (3) Using UFIM, (4) Model Logic, (5) Help Index, and (6) Help
on Help, Figure 2-14. This manual and the Basic Concepts volume will be
added soon.

Figure 2-14: Help Menu Options

The Help on Help item is worth noting. From any screen you can press F 1 to
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get help for that screen. You can also select the help menu from the main
menu bar. Each heading in the menu is linked to a series of informational
screens, the whole of which covers most topics relating to the model.

On many of the screens, several topics are listed in bold at the bottom of
the page. These are additional topics related to the current help topic. To
access help on these topics, move the cursor using TAB and press ENTER.
In this way you can reach any topic through the help menu, though you may
have to pass through one or two other screens first.
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